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Preface 

About this guide 

This document explains the procedure to install and setup the Resource Modeler tool. This document also explains the 
process to use the tool and to create resource model and NFV Director template. 

Audience 

This document is for any stakeholder requiring to design the NFV Director Template and Instance offline, and upload 
them to NFV Director later. Pre requisite is to have knowledge of NFV Director concepts, and an understanding of NFV 
Director resource model. 

Document history 

Table 1: Document history 

Edition Date Description 
1.0 15 Feb 2017 First edition. 
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Chapter 1 Installing the Resource Modeler 

1.1 Installation Process 

Download the Resource Modeler from the NFV Director ISO to a Windows system, and unzip the 
package in the desired directory. 

Launch the Resource Modeler GUI by running the nfvdesigner.exe 
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Chapter 2 Creation and edition of a NFV diagram 

2.1 Creating a new file 

The editor stores each NFV diagram in an xml file with “nfvd” extension. 

The first step when working with the editor is creating a new empty file. 

In the menu, select: File / New 

The wizard for creation of new files appears. 

 

Figure 1: Create new nfvd file 

Select NFV Diagram and Click on Next >. 

The destination file page appears. 
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Figure 2: Create new NFV Diagram 

Click on ... and select the folder where the new file will be created. 

Replace the suggested name with your preferred name. (Maintaining the .nfvd extension). 

Click On Finish. 

A new empty diagram appears on the editor. 
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Figure 3: Empty NFV Diagram 

2.2 Adding artifacts 

In the Artifacts Palette on the left panel, expand the group containing the desired artifact, and select 
the desired artifact. 

 

Figure 4: Artifact Palette 

Next, add the artifact to the editor area. This can be done in two ways: 
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 Click on the artifact name in the Artifacts Palette, and then click on any point of the editor area. 

 Drag and drop from the Artifacts Palette to the editor area. 

A new figure appears in the editor. 

 

Figure 5: Drag and Drop artifact from Artifact Palette 

2.2.1 Palette filters 

You can choose which elements are shown in the Artifacts Palette, if you expand the pull-down at the 
top of the palette and select All, Physical or Not Physical. All is selected by default. 

 

Figure 6: Palette Filter 
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2.3 Adding relationships between artifacts 

You can add a Relationship between two Artifacts (supposing that there exists a Relationship 
Definition corresponding to these two Artifacts as child and parent). 

Click on the Relationships button . The editor enters in Relationship Creation mode. 

Next, connect two artifacts. This can be done in two ways: 

 Click on the artifact that will be the parent, and then click on the artifact that will be the child. 

 Drag and drop from the artifact that will be the parent to the artifact that will be the child. 

 

Figure 7: Adding relationship between artifacts 

A new connection appears in the diagram joining the Artifacts. 
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Figure 8: New connection 

You can continue adding more Relationships, or exit the Relationship Creation mode at any time by 

Clicking on ESC key, or by clicking the  button to get back to Selection mode. 

2.4 Moving and resizing artifacts 

The artifacts can be moved to any location of the editor by drag and drop. 

 

Figure 9: Moving artifacts 

The artifacts can be resized by pointing to one of its sizing handles, and dragging the handle. 

 

Figure 10: Resizing artifacts 
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2.5 Selecting artifacts or relationships 

If the Selection Mode is active (  button is active), you can select one or more Artifacts or 
Relationship. There exist multiple possible ways to do it: 

 Click on an Artifact or Relationship to select it. 

 

Figure 11: Selecting artifact or relationship 

 Hold CTRL key and click on more Artifacts or Relationships to add them to the current selection, 
or to remove an Artifact or Relationship from the current selection. 

 

Figure 12: Add artifact or relationship to current selection 

 You can also select by dragging a rectangle from any empty point of the diagram. This way, the 
selection will include all the enclosed elements. 

 

Figure 13: Dragging rectangle to select artifact or relationship 

 Alternatively, you can click on Select All in the Toolbar, or Edit / Select All in the menu, to select 
all the Artifacts and Relationships of the diagram. 
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2.6 Deleting artifacts or relationships 

To delete the currently selected Artifact/s or Relationship/s, Click on DEL key, or click  in the 
Toolbar, or Edit / Delete in the Menu.  

2.7 Editing the properties of an artifact or relationship 

The properties of the last selected Artifact or Relationship appear on the Properties panel on the 
right. (The Properties panel can be resized or dragged to another position). 

The panel is divided on two main groups, the general section and the categories section. 

The general section offers a button for show / hide advanced properties. 

 

Figure 14: Editing properties of artifact or relationship 

The categories section allows to expand categories in order to show the attributes table. 
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Figure 15: Category section 

The elements that contain an empty required value are marked with (*) before the property key. 

Some columns in attributes table show special buttons for custom actions when clicked over them, 
like restrictions column. The following example explain how to manage restrictions. 

First push the manage button on restrictions column. 

 

Figure 16: Manage restrictions 

Second push the add button in restriction column of the opened dialog. 

 

Figure 17: Push add button in restriction column 

Third fill the new restriction dialog. 
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Figure 18: Fill the restriction dialog 

Finally the new restriction appear in list. Push the edit or delete button on edit / delete column in 
order to manage the new restriction. 

 

Figure 19: Manage the new restriction 

2.8 Changing the color of an artifact or relationship 

The color of the currently selected Artifact/s and Relationship/s can be changed by right click / 
Change color... 
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Figure 20: Change color of an artifact or relationship 

2.9 Moving artifacts up or down in the diagram 

The stack order of Artifacts in the diagram can be changed by clicking on the Order buttons in the 
Menu, or the corresponding buttons in the Toolbar. 

 

Figure 21: Moving artifacts up or down 

In the example below, we selected INTERFACE:GENERIC and moved it down. 

   

Figure 22: Example of artifact moving down 

2.10 Changing the zoom in the editor 

The Zoom in the editor can be changed with the Zoom drop-down in the Toolbar. 
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Figure 23: Changing zoom 

Another way to zoom-in or zoom-out is by holding CTRL key and scrolling the mouse wheel. 

2.11 Allowing root artifacts automatic changes 

This option can be enabled on the toolbar, it ask for permission to change the root artifacts name and 
description and replace them with the group name and description. 

 

Figure 24: Enable automatic changes in root artifacts 

2.12 UUID regeneration 

Push the toolbar button for the UUID regeneration, the action will ask for permission. Keep in mind 
that all the artifacts and components UUIDs will be regenerated. 

 

Figure 25: Regenerate UUID 

2.13 Artifacts filter 

Window -> Filters give access to the filters dialog, the dialog offers simple text filters for artifacts and 
relationships. With the use of the special character “$” we can concatenate filters and apply them. 
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Figure 26: Filter artifacts and relationships 

 

You can also access the filters dialog with the filters action of the artifacts editor toolbar. 

 

Figure 27: Filter action 
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Chapter 3 Trees/Groups 

3.1 Creating, editing or deleting a group 

Click on the Groups tab on the panel on the right of the editor. (The Groups panel can be resized or 
dragged to another position). 

 

Figure 28: Groups tab 

To add new groups, click Add group... and complete the attributes of the group. 

First, fill the basic attributes, Id, Group name, type and optionally the description and color. 

Second, optionally fills the component source attribute, and the group source template attribute, also 
you can add custom component scopes to the list. 

Third, optionally you can select the Artifacts from the diagram that will be set as root Artifacts of the 
group, the selected ones will be added to the group if they were not already included. 

 Click OK to confirm. 
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Figure 29: Add new groups 

To edit a group, select its name and click Edit group... Click OK to confirm the changes. 

To remove a group, select its name and click Remove group. 

There exists a special non-editable group, named Others, that will always contain the elements that 
are not included in any other group. 
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3.2 Adding or removing artifacts or relationships 
to/from a group 

To add the currently selected Artifact/s or Relationship/s to a group, Click On right click on the 
mouse and click on Groups in the context menu that appears. (Note: for the option to appear, there 
must exist at least one group). 

 

Figure 30: Add artifacts or relationships to a group 

A submenu with the existing groups will show up, each one with a checkbox you can check to add 
the item/s to it, or uncheck to remove the item/s from it. 

 

Figure 31: checkbox to add or remove items from group 

Any Artifact or Relationship can be added to one or more groups. 

When an artifact is contained on a group, a small box with the corresponding color will appear on the 
figure. 



Trees/Groups   27 

 

Figure 32: Color indicating artifact contained in a group 

3.3 Adding group root artifacts 

To add the currently selected Artifact/s to a group as root Artifacts, Click On right click on the mouse 
and click on Check/Uncheck Root in the context menu that appears. 

 

Figure 33: Adding artifacts to group as root 

A submenu with the groups that contain the Artifacts will show up, each one with a checkbox you can 
check to set the item/s as roots, or uncheck to unset the item/s as roots. 

 

 

Figure 34: Check/Uncheck root artifact from a group 

Any Artifact can be set as root in more than one group. 

When an artifact is the group root artifact, an icon will be show on the editor. 
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Figure 35: Icon indicating group root artifact 

3.4 Showing or hiding groups 

In the Groups selection dialog, use the checkbox next to each group name to control which elements 
are shown or hidden in the diagram. 

 Checking a group will make visible all the contained Artifacts and Relationships. 

 Unchecking a group will hide the Artifacts and Relationships that are not contained in any other 
visible group. 

 

Figure 36: Showing or hiding groups 

Unchecking Example group hides IPADDRESS:GENERIC 
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Figure 37: unchecking group hides artifact 

INTERFACE:GENERIC will hide if we uncheck the 3 groups it belongs to. 

 

Figure 38: Hiding artifacts belonging to multiple groups 
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Chapter 4 Components 

4.1 Overview 

A component is the visual representation of a group. They have their own editor, in order to access it, 
you can simply switch between the artifacts and components tab at the bottom of the application, 
right above the status bar. 

 

Figure 39: Components tab 

4.2 Adding relationships between components 

You can add a Relationship between two Components, but keep in mind one restriction. If the target 
component is child (target) of another component, checkout that following the targets direction you 
cannot reach the father (source) component that you try to connect with. 

Click on the Relationships button . The editor enters in Relationship Creation mode. 
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Next, connect two components. This can be done in two ways: 

 Click on the component that will be the parent, and then click on the component that will be the 
child. 

 Drag and drop from the component that will be the parent to the component that will be the 
child. 

 

Figure 40: Connect two components 

 

 

A new connection appears in the diagram joining the Components. 
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Figure 41: New connection joining the components 

You can continue adding more Relationships, or exit the Relationship Creation mode at any time by 

Clicking on ESC key, or by clicking the  button to get back to Selection mode. 

4.3 Changing the color of a component or relationship 

The color of the currently selected Component/s and Relationship/s can be changed by right click / 
Change color... 

 

Figure 42: Changing color of a component 
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4.4 Moving and resizing components 

The components can be moved to any location of the editor by drag and drop. 

 

Figure 43: moving a component 

The components can be resized by pointing to one of its sizing handles, and dragging the handle. 

 

Figure 44: resizing a component 

4.5 Selecting components or relationships 

If the Selection Mode is active (  button is active), you can select one or more Components or 
Relationship. There exist multiple possible ways to do it: 

 Click on a Component or Relationship to select it. 

 

Figure 45: Select a component or relationship 

 

 Hold CTRL key and click on more Components or Relationships to add them to the current 
selection, or to remove a Component or Relationship from the current selection. 
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Figure 46: Selecting multiple components and relationship 

 You can also select by dragging a rectangle from any empty point of the diagram. This way, the 
selection will include all the enclosed elements. 

 

Figure 47: Dragging rectangle from empty point to select components and relationships 

 Alternatively, you can click on Select All in the Toolbar, or Edit / Select All in the menu, to select 
all the Components and Relationships of the diagram. 

4.6 Deleting relationships 

To delete the currently selected Relationship/s, Click on DEL key, or click  in the Toolbar, or Edit 
/ Delete in the Menu.  

4.7 Changing the zoom in the editor 

The Zoom in the editor can be changed with the Zoom drop-down in the Toolbar. 
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Figure 48: changing zoom in editor 

Another way to zoom-in or zoom-out is by holding CTRL key and scrolling the mouse wheel. 

4.8 Predefined components management 

There are cases where you may want to reuse groups between diagrams, for example if you want to 
create a common palette of components. To do this, simply create a new diagram with a group or 
groups with artifacts and relationships that you want to share. 

Next save the diagram and copy it to the resources / components folder on the editor installation 
folder, then the contents will be available in the components view palette. 

You can also use File -> Save as predefined component, the diagram will be saved to the resources / 
components folder directly. 
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Figure 49: Saving as predefined component 

Just drag the component from the palette to the board and the component will be created along with 
his member artifacts and relationships. 

The editor reads the components from the .nfvd files on the resources / components folder, but if you 
do not need all the components loaded or want to focus only on a few of them, Click On the “
Components” button on the toolbar and check / uncheck the desired components on the dialog. 
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Figure 50: Drag components to editor 

4.9 Components properties 

Some artifact properties can also be edited from the components view. If you select a component and 
switch to the properties view, a list with all the member artifacts will appear. Expand the desired 
artifact to see their categories, the categories that have any attribute with a restriction with the field 
"type" not empty, will appear expanded by default 

If the restriction type is “user-input”, then the value is editable, if the restriction type is “display”, the 
value is read-only. When the restriction type is “user-input”, and the restriction have values on it, then 
the value on the properties section will change from open text to combo box. 
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Figure 51: Component properties 
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Chapter 5 Connectors 

5.1 Overview 

Connectors stablish the Artifacts that will be entry points between groups with the allowed 
relationship to connect them. 

5.2 Creating, editing or deleting a connector 

First go to the components tab, select the component that will hold the connector and then click on 
the Connectors tab on the panel on the right of the editor. (The Connectors panel can be resized or 
dragged to another position). 

 

Figure 52: connector tab 
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To add new connectors, click Add connector... and complete the attributes of the connector.  

First, select from the list one of the Artifacts included in the group, this will filter the list to the same 
type of Artifacts, then you can select more Artifacts of the same type to include to the connector if 
you want. 

Second, set if the Artifacts will take the Parent or Child role in the relationship. 

Third, fill the relationship attributes, each combo box will update dependent on the selected value on 
the previous ones.  

Finally, you can add any optional inclusion or exclusion to the connector. 

Click OK to confirm. 
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Figure 53: Add connector 

To edit a connector, select its name and click Edit connector... Click OK to confirm the changes. 

To remove a connector, select its name and click Remove connector. 

If a component contains any connector, an icon will be show on the editor. 

 

Figure 54: Remove connector 

5.3 Creating virtual relation between connectors 

These relation types, really connects the artifacts pointed by the connectors based on the connectors 
information. In order to establish the relation Click On the connectors connection icon on the 
components editor toolbar. 

 

Figure 55: connection icon 

Once the connection tool is active you need to select the source component and the source 
connector. 
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Figure 56: Select connector 

Then, select the target component and the target connector, the type of the source and target 
connectors must be the same. Also if the relation is successful, a new relationship between the source 
group and the target group will be created, if the relation cannot be established between the groups, 
the target group will not be highlighted discarding the relationship between connectors. 
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Figure 57: Select target connector and component 

If the relation can be established with no errors, a confirmation message will show up. The tool also 
validates the connector information, the incompatible artifacts will not be connected, and also it will 
try to not duplicate the relationships. 

 

 

Figure 58: Connection established successfully 
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Chapter 6 Group relations 

6.1 Overview 

When a group has child or parent relationship with another group, you may want to define also 
relations between their member artifacts. This relations help to define the group relationship context 
or meaning. The relationship information will be stored on the parent group, that is, the relation will 
be a member of the parent group. 

6.2 Creating, editing or deleting a relation 

First go to the components tab, select the group relationship that will hold the relation and then click 
on the Relations tab on the panel on the right of the editor. (The Relations panel can be resized or 
dragged to another position). 

 

Figure 59: Relationship editor 

To add new relations, click Add relation... and complete the attributes of the relation. 

First, select from the list one of the parent group Artifacts and their role in the relationship (Child or 
Parent). 

Second, select from the list one of the child group Artifacts and their role in the relationship (Child or 
Parent). 

Third, fill the relationship attributes, each combo box will update dependent on the selected value on 
the previous ones.  
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Click OK to confirm. 

 

Figure 60: Add relationship 

The new relation will appear on the Artifacts tab. 

 

Figure 61: New relationship 

To edit a relation, select it from the list and click Edit relation... Click OK to confirm the changes. 

To remove a relation, select it from the list and click Remove relation. 
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Chapter 7 Export/Import 

7.1 Exporting a diagram to V2 or other XML 

To export a diagram: 

Click File / Export... in the Menu bar. 

 

Figure 62: Export NFV Diagram to XML 

Select Export NFV Diagram to xml and Click on Next >. 

At this point, if it exists any Artifact or Relationship with any mandatory value empty, there will 
appear a Warning window reminding that we should complete these values. Nevertheless, we can 
continue the export anyway. 
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Figure 63: Validation error while exporting NFV Diagram to XML 

The destination file page appears. 
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Figure 64: Provide XML name to export to 

Click on ... and select the folder where the new file will be created. 

Replace the suggested name with your preferred name. (Maintaining the .xml extension). 

Select the diagram type (Instance or Template). 

Select the export option: 

- Select items, items filter by the groups, artifacts and relations. 

- Visible items, only items marked as visible on the editor 

- All items, export all. 

Select items is the default option with all the items selected by default. 

Click On Finish. 
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The diagram will be exported and a confirmation window will appear. 

 

Figure 65: Successful export to XML 

7.2 Importing a diagram from a V2 or other XML file 

To import an existing xml file: 

Click File / Import... in the Menu bar. The import wizard appears. 

 

Figure 66: Import NFV Diagram 



Export/Import   50 

Select Import NFV Diagram and Click on Next >. 

The file selection page appears. 

 

Figure 67: Select XML file to import 

Click On the ... button next to the first field and select the file to import. 

Click On the ... button next to the second field and select the folder where the new file will be created. 

Replace the suggested name with your preferred name. (Maintaining the .nfvd extension). 

Select the xml format (V2 or Others). 

Click On Finish. 

The diagram will be imported and opened in the editor. 
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Chapter 8 Diagram Definitions 

It’s possible to add new Definition Sources to the editor, and to edit or remove any of them. 

The editor has always an active Definition Source. It ships with an initial Default Definition Source as the active one, and 
the user can change the active Definition Source to any other. 

The active Definition Source determines the available Artifacts in the Palette, and the internal details of each one 
(categories, available status, possible types of Relationships, etc.). 

8.1 Adding a Definition Source 

To add a new Definition source click on Window / Preferences, and select NFV Preferences. 

 

Figure 68: NFV preferences 

Click on New Definitions Source. 
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Figure 69: New definitions source 

Fill-in the name. 

Click on Add files, and select the xml file with the definition you want to add. You can add one or more Definition files. 

 

Figure 70: Adding definition files to new definition source 

When it’s complete, click On OK. 

The new Definition Source has been added to the editor. 
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Figure 71: Successful addition of new definition source 

8.2 Selecting the active diagram definition 

To select the active Definition source, click on Window / Preferences, and select NFV Preferences. 

Use the checkbox to select the preferred Definition Source. 

 

Figure 72: Setting active diagram definition 

Click on OK to confirm. 
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8.3 Editing an existing diagram definition 

Click on Window / Preferences, and select NFV Preferences. 

8.3.1 Adding new definitions to a definition source 

Right-click on the Definition Source you want to remove, and select Add new definitions. 

 

Figure 73: Editing existing diagram definition 

Click on the button to select the new definitions file. 

 

Figure 74: Select definition file 

If you select Modify current source, the new definition will be added to the selected Definition Source. 
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Figure 75: Select modify option 

If you select Create new source, a new Definition Source will be created based on the selected one, and including this 
change. 

 

Figure 76: Select create option 
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Figure 77: New definition created 

Click on OK to confirm. 

8.3.2 Deleting definitions from a definition source 

Right-click on the Definition Source you want to remove, and select Delete definitions. 

 

Figure 78: Delete definition 

A window showing the tree of elements (Artifacts and Relationships) of the selected definition will appear. 

Select the element you want to delete. 
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Figure 79: Select definitions to delete 

If you select Modify current source, the selected element will be removed from the selected Definition Source. 

If you select Create new source, a new Definition Source will be created based on the selected one, and including this 
change. 
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Figure 80: Modify or create definition 

 

 

Figure 81: New definition added 
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Click on OK to confirm. 

8.3.3 Modifying definitions from a Definition Source 

Right-click on the Definition Source you want to remove, and select Modify definitions. 

 

Figure 82: Modify definition 

A window showing the tree of elements (Artifacts and Relationships) of the selected definition will appear. 

Double click on the element you want to delete. 

 

Figure 83: Select definitions to modify 
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Type the changes in the xml. 

 

Figure 84: Edit definition XML 

Click on OK to confirm the changes. 

If you select Modify current source, the selected Definition Source will be updated with the modification. 

If you select Create new source, a new Definition Source will be created based on the selected one, and including this 
modification. 
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Figure 85: Create or modify definition 

 

 

Figure 86: New definition added 
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Click on OK to confirm. 

8.4 Removing an existing diagram definition 

Click on Window / Preferences, and select NFV Preferences. 

Right-click on the Definition Source you want to remove, and select Delete. 

 

Figure 87: Select definition to delete 

(NOTE: you can’t remove the Default or the Active Definition Source). 

Click on OK to confirm. 
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Chapter 9 Definitions editor 

Plus the definitions edition capabilities on the preferences page, you can use the more visual friendly definitions editor for 
your edition tasks. To access the editor just follow Window -> Definitions Editor. 

9.1 Modify definitions 

First select a definition source from the list and wait definitions to load. Once the definitions are loaded on the list, select 
the definition type on the combo box, the options are Artifact or Relationship, after that, you can search the definition on 
the list or use the textbox filters allowed for that definition type. 

To modify the selected definition just change values on the properties or categories table and save the definition as a 
normal file. Keep in mind that you cannot modify the default editor definitions, if you want to modify it, use “Save As” 
instead of “Save”, this will create a new definitions source. 

 

Figure 88: Definitions editor 

9.2 Create definitions 

Push “New definition” button and select the definition type on the wizard dialog.  
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Figure 89: Selecting definition type 

Next, fill the definition properties and status in the next page. 
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Figure 90: Fill definition properties 

Finally, create the definition categories and attributes, Click On finish to add the new definition to the definitions source. 
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Figure 91: Create definition category 

9.3 Edit definitions 

In order to edit definitions, select one definition from the list and push the “Edit” button. The edition wizard is the same as 
the “New definitions“ wizard, just follow it and edit the desired values. 
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Figure 92: Edit definition 
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Figure 93: Edit, add or remove attributes 

9.4 Delete definitions 

Select the definition from the list and push “Delete” button to delete it from the definitions source. 

9.5 Import definitions source 

Push the Import definitions button, then the add files button and select the desired .xml definition files. 
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Figure 94: New definitions source 

Click On the “Ok” button, a new definitions source will be added into the list. 

9.6 Export definitions source 

Push Export definitions button, select the output folder and the export type, “Splitted” for one file per definition and “One 
single file” to merge all definitions in one single file.  

 

 

Figure 95: Export definitions source 
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9.7 Delete definitions source 

To delete a definitions source, select one of the list and push the “Remove definitions” button. You cannot delete the 
default definitions source. Also if the definitions source are active you must switch to another source in order to delete it. 
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Chapter 10 Preferences 

10.1 General section 

To open the editor preferences just go to Window -> Preferences and select the NFV Preferences to see the general 
section settings. To access other sections just expand NFV Preferences and select them. 

 

Figure 96: General NFV preferences 

The actual available preferences are: 

Show artifact images on editor: when enabled, the artifact identifier text gets replaced by the configured artifact image. 

Show component images on editor: when enabled, configured component image is shown. 

Enable Undo/Redo: improve performance on large diagrams when enabled. 

User Domain: domain on which the user has access rights. 

User Name: the user name. 

User Password: the user password. 

You can restore the default values or push OK to perform changes. 

 



Preferences   72 

10.2 Artifacts images 

In this section you can configure the Artifacts images. Expands a family and selects from disk the image that will apply for 
the desired category, you can also set up the family category NFV_DEFAULT, that image will apply for all the categories 
without image. 

 

Figure 97: Configure artifacts images 

You can restore the default values or push OK to perform changes. 

10.3 Components images 

In this section you can configure images for the groups loaded in the editor, just selects from disk the image that will 
apply for the desired group. 
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Figure 98: Manage component images 

You can restore the default values or push OK to perform changes. 

10.4 Definitions 

Go to section 9 of this manual to read more about how to handle definitions on this preferences section. 

10.5 Servers management 

In this section you can add, edit or delete server URLs for posterior selection. 
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Figure 99: Servers management 

You can restore the default values or push OK to perform changes. 

To change to online mode on the editor and selects one of the servers previously added on the preferences section just 
click the connect icon on editor toolbar. 

 

Figure 100: connect icon 

Then select the server from the list and Click on OK. 

 

Figure 101: Server selection 
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Chapter 11 Documentation 

11.1 Definitions documentation 

Go to Help -> Definitions Documentation, a dialog will show up with two options, view and export. 

 

Figure 102: Definitions documentation 

The view option opens the documentation in the editor. 

 

Figure 103: Documentation editor 

The export option allow to save the documentation as html on disk. 
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Figure 104: Export documentation 
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Chapter 12 Validations 

12.1 Introduction 

Whenever an Artifact or a Relationship has any of its mandatory fields empty, the editor shows a “(*)” mark next to its 
label in the editor. 

If we select an Artifact or Relationship with validation errors, we can see the particular field that requires completion, with 
another “(*)” mark next to the name of the field. 

When an export is being performed, a validation will be done, and if there is any Artifact or Relationship with any 
mandatory value empty, there will appear a Warning window reminding that we should complete these values. 
Nevertheless, we can continue the export anyway. 

12.1.1 Text on the cover 

The cover page contains the document title, subtitle and release / part number / edition information fields. Modify or 
delete these entries as required. These fields use the built-in title, subtitle and cover release/edition fields respectively. Do 
not use these styles for other purpose. 

12.1.2 Graphics on the cover 

The template comes with the standard cover page. Choose the appropriate cover page with the image matching the PDF 
documentation set or your needs from the HPE cover page gallery of the template. 

1. Select the current cover page. 
2. Go to the Insert tab of the Ribbon. 
3. Open the Cover Page drop-down list and scroll down to the HPE section at the bottom. 
4. Choose the appropriate cover page. This replaces the current cover page with the chosen cover page. 

If the replacement does not happen, any additional cover pages can be deleted manually. 


